Model Development and Incorporation of GIS Tools for Floodplain Management

Andrew P. Darnell

West Virginia University

Follow this and additional works at: https://researchrepository.wvu.edu/etd

Recommended Citation
https://researchrepository.wvu.edu/etd/308

This Thesis is protected by copyright and/or related rights. It has been brought to you by the The Research Repository @ WVU with permission from the rights-holder(s). You are free to use this Thesis in any way that is permitted by the copyright and related rights legislation that applies to your use. For other uses you must obtain permission from the rights-holder(s) directly, unless additional rights are indicated by a Creative Commons license in the record and/or on the work itself. This Thesis has been accepted for inclusion in WVU Graduate Theses, Dissertations, and Problem Reports collection by an authorized administrator of The Research Repository @ WVU. For more information, please contact researchrepository@mail.wvu.edu.
Model Development and Incorporation of GIS Tools for Floodplain Management

By
Andrew P. Darnell, EIT

Thesis submitted to the College of Engineering and Mineral Resources at West Virginia University in partial fulfillment of the requirements for the degree of Master of Science in Civil and Environmental Engineering

Dr. John D. Quaranta, Ph.D., P.E., Chair
Dr. Hema Siriwardane, Ph.D., P.E.
Dr. Leslie Hopkinson, Ph.D.

Department of Civil and Environmental Engineering

Morgantown, West Virginia

2011

ABSTRACT

Model Development and Incorporation of GIS Tools for Floodplain Management

Andrew P. Darnell

Floodplain management consists of efforts to reduce flood damage to critical infrastructure and to protect the life and health of individuals from flooding. A major component of this effort is the monitoring of flood control structures such as dams because the potential failure of these structures may have catastrophic consequences. In order to prepare for these threats, engineers utilize inundation maps that model the flood resulting from high river stages. To create the maps, the structure and river systems are modeled using engineering software programs, and hydrologic events are used to simulate the conditions leading to the failure of the structure. The output data is then exported to other software programs for the creation of inundation maps. While the computer programs for this process have been established, the processing procedures vary and yield inconsistent results. Thus, these processing methods need to be examined to determine the functionality of each in floodplain management practices.

The main purpose of this work was to develop a more integrated, accurate, and precise graphical interface tool for interpretation by floodplain engineers and emergency responders. To accomplish this purpose, a potential dam failure was simulated and analyzed for a candidate river system using two processing methods: ArcToolbox and Terrain Tiles. The work scope involved performing a comparison of the outputs, which revealed that both procedures yielded similar inundations for single river reaches. However, the results of this study indicated key differences when examining outputs for large river systems. Based on criteria involving the hydrologic accuracy and effects on infrastructure, the Terrain Tiles inundation surpassed the ArcToolbox inundation in terms of following topography and calculating flow rates and flood extents at confluences, bends, and tributary streams. Thus, the Terrain Tiles procedure is a more accurate representation of flood extents for use by floodplain engineers and emergency responders.
Acknowledgments

I would like to acknowledge the supervision of Dr. John D. Quaranta. His insight and guidance proved to be invaluable over the duration of this work, and I thank him for serving as my advisor. I wish to thank Dr. Hema Siriwardane and Dr. Leslie Hopkinson for serving on my research advisory committee. I would also like to thank Mr. Richard Wise and Mr. Brian Lavigne for their assistance in the completion of this work.

I gratefully acknowledge the United States Army Corps of Engineers for their financial support and guidance from the initial data acquisition to the completed product. Furthermore, I would like to thank Wheeling Jesuit University for their support in the overall efforts of this work.
# Table of Contents

Abstract .................................................................................................................................................. ii  
Acknowledgments .................................................................................................................................. iii  
List of Tables and Figures ....................................................................................................................... vii  

## 1.0 Introduction

1.1 Objectives and Purpose...................................................................................................................... 2 
1.2 Scope of Work ...................................................................................................................................... 2 
1.2.1 Task 1: Literature Review ............................................................................................................... 2 
1.2.2 Task 2: Hydrologic Modeling ........................................................................................................... 3 
1.2.3 Task 3: Data Analysis ....................................................................................................................... 3 
1.2.4 Task 4: Summary of Results .......................................................................................................... 3 

## 2.0 Literature Review

2.1 HEC-RAS ........................................................................................................................................... 5 
2.2 HEC-GeoRAS ..................................................................................................................................... 7 
2.3 ArcGIS ............................................................................................................................................... 8 

## 3.0 Modeling and Mapping Methods

3.1 Data Acquisition ............................................................................................................................... 11 
3.2 ArcToolbox Procedure ..................................................................................................................... 13 
3.2.1 Create HEC-RAS Output Data ....................................................................................................... 13 
3.2.2 Export HEC-RAS Data ................................................................................................................... 13 
3.2.3 Convert SDF File to XML File ..................................................................................................... 14 
3.2.4 Set Up Analysis Layer .................................................................................................................. 15 
3.2.5 Import HEC-RAS Output Data ..................................................................................................... 15 
3.2.6 Generate Water Surface TIN ...................................................................................................... 17 
3.2.7 Convert TIN to Raster ................................................................................................................... 17 
3.2.8 Delete DEM from Raster .............................................................................................................. 18 
3.2.9 Reclassify Raster .......................................................................................................................... 18 
3.2.10 Convert Raster to Polygon ......................................................................................................... 19 
3.2.11 Delete Negative Values ............................................................................................................. 20 
3.2.12 Clip Counties and Cities .......................................................................................................... 21 
3.2.13 Add Background Imagery ......................................................................................................... 23 
3.3 Terrain Tiles Procedure ................................................................................................................... 25 
3.3.1 Create New Polygon Shapefile ................................................................................................... 25 
3.3.2 Sketch First Polygon ................................................................................................................... 26
# List of Tables and Figures

Table 1: FEMA Sectors ................................................................................................................ 4

Figure 1: HEC-RAS Input ........................................................................................................ 11

Figure 2: GIS Export .................................................................................................................. 14

Figure 3: Convert RAS Export .................................................................................................. 14

Figure 4: Layer Setup ................................................................................................................ 15

Figure 5: Import RAS Data ....................................................................................................... 16

Figure 6: Visualization of HEC-RAS Data ............................................................................... 16

Figure 7: Select Water Surface Profile ...................................................................................... 17

Figure 8: TIN to Raster ............................................................................................................. 18

Figure 9: Minus Tool ................................................................................................................. 18

Figure 10: Reclassify ................................................................................................................ 19

Figure 11: Classification ........................................................................................................... 19

Figure 12: Raster to Polygon ..................................................................................................... 20

Figure 13: Attribute Table ....................................................................................................... 20

Figure 14: Resulting Inundation ............................................................................................... 21

Figure 15: Select by Attributes ................................................................................................. 22

Figure 16: Select by Location ................................................................................................... 22

Figure 17: Flood Overlain on Aerial Photography ................................................................. 23

Figure 18: Create Contours .................................................................................................... 24

Figure 19: Flood Overlain on Contours ................................................................................... 24

Figure 20: Create New Shapefile ............................................................................................ 25

Figure 21: Sketch Polygon ....................................................................................................... 26

Figure 22: Specify Options ....................................................................................................... 27

Figure 23: Raster Calculator .................................................................................................... 28

Figure 24: Make Permanent .................................................................................................... 28

Figure 25: Sketch Second Polygon ......................................................................................... 29

Figure 26: Create TIN ............................................................................................................. 30

Figure 27: Specify Map Name ................................................................................................. 31

Figure 28: Specify Name for Terrain Tiles ............................................................................... 31

Figure 29: Sketch First Terrain Tile ....................................................................................... 32

Figure 30: TerrainTiles Attribute Table ................................................................................. 33

Figure 31: Sketch Second Terrain Tile ................................................................................... 34

Figure 32: Clip Polygon ........................................................................................................... 34
Figure 33: Populated TerrainTiles Attribute Table .................................................................35
Figure 34: Analysis Layer Setup .........................................................................................36
Figure 35: Floodplain Delineation ......................................................................................38
Figure 36: Inundation Polygon .........................................................................................38
Figure 37: Inundation Depths ............................................................................................38
Figure 38: Options ................................................................................................................40
Figure 39: Environment Settings .......................................................................................40
Figure 40: Create Contours ...............................................................................................41
Figure 41: Boundary Polygon with Road Layers .................................................................43
Figure 42: Clip Roads ..........................................................................................................44
Figure 43: Layer Properties ...............................................................................................45
Figure 44: Assign Halo .........................................................................................................46
Figure 45: Convert to Annotation .......................................................................................46
Figure 46: Select Symbols .................................................................................................47
Figure 47: 6-Mile by 8-Mile Block .....................................................................................49
Figure 48: Highlight Cross-Section ....................................................................................50
Figure 49: Specify Cross-Section .......................................................................................51
Figure 50: Crop Cross-Section ............................................................................................51
Figure 51: Select Template ................................................................................................52
Figure 52: Page and Print Setup ........................................................................................53
Figure 53: Data Frame Properties ......................................................................................54
Figure 54: Add Legend ........................................................................................................56
Figure 55: ArcToolbox Inundation (0 Hours) .....................................................................58
Figure 56: ArcToolbox Inundation (21 Hours) ..................................................................59
Figure 57: ArcToolbox Inundation (43 Hours) ..................................................................60
Figure 58: Terrain Tiles Inundation (0 Hours) ..................................................................61
Figure 59: Terrain Tiles Inundation (21 Hours) .................................................................62
Figure 60: Terrain Tiles Inundation (43 Hours) .................................................................63
Figure 61: Critical Infrastructure Legend .........................................................................64
Figure 62: ArcToolbox Full Reach .....................................................................................65
Figure 63: Terrain Tiles Full Reach ...................................................................................66
Figure 64: ArcToolbox Confluence ...................................................................................68
Figure 65: Terrain Tiles Confluence ..................................................................................68
Figure 66: ArcToolbox Straight Segment ...........................................................................70
Figure 67: Terrain Tiles Straight Segment .................................................................70
Figure 68: ArcToolbox River Bend ..............................................................................72
Figure 69: Terrain Tiles River Bend .............................................................................72
1.0 Introduction

Dams serve many functions in society, providing hydropower, flood control, water supply, navigation, and recreation. While dams provide many benefits, they can also pose a threat if proper safety inspection and planning are not conducted. The United States Army Corps of Engineers (USACE) alone is responsible for 569 dams, and almost 65 percent of these dams are over 30 years old, while 28 percent have reached or exceeded the 50-year design life (ERDC, 2010). The USACE manages the risks of the potential failure of these dams and is entrusted with protecting the public from the devastation caused by dam failures.

Dam failure analysis is a component of floodplain management, and the potential impacts of a dam failure on areas downstream are of primary importance to floodplain engineers and emergency responders. The most effective presentation of these impacts is provided by inundation maps that show the extents of the ensuing flood at key times and locations after the dam failure. There are several methods that are currently used to produce these maps, and each method has benefits and potential drawbacks. However, an assessment of these processes has not been fully examined to determine the appropriate uses of the methods in floodplain management. Thus, research efforts on inundation mapping are performed to investigate these methods and potential applications. The research is divided into the following four tasks: i) prepare literature reviews on applicable computer programs used in floodplain mapping, ii) perform hydrologic modeling for a candidate river system using two methods, iii) analyze the output data for each method, and iv) provide a summary of the results.
1.1 Objectives and Purpose

The objectives of this research are to investigate mapping methods which integrate existing United States Army Corps of Engineers computer programs (HEC-RAS, HEC-GeoRAS) with output data into an ArcGIS system for analysis of floodplain inundation which incorporates high-resolution imaging and critical infrastructure information. Further objectives are to describe the respective computer programs; to identify key features of data input, function, and generated output for analysis of river stage levels due to hydrologic events; and to perform data analysis consisting of a review of the functionality, benefits, and potential drawbacks. The specific purpose of this work is to develop a more integrated, accurate, and precise graphical interface tool for the development and interpretation of flood extents by floodplain engineers and emergency responders.

1.2 Scope of Work

The scope of work provides the procedure followed throughout the research process. The project tasks are discussed briefly in the following paragraphs.

1.2.1 Task 1: Literature Review

A literature review is performed in order to provide an understanding of the importance of developing inundation maps for dam failures based on the current state-of-practice set forth by the Federal Emergency Management Agency (FEMA). The literature review identifies and discusses current computer programs and tools used for modeling and analyzing rivers, dams, and floodplains relevant to this research.
1.2.2 Task 2: Hydrologic Modeling

Hydrologic modeling is a complex process that requires the use of several software programs. First, the dam and rivers are modeled based on field measurements, and hydrologic events are input into the model as initiating conditions for high water levels, or in this case simulating a dam failure. Once the dam failure is modeled, the simulation is performed, creating output data for the resulting flood, including arrival times, flow rates, and water elevations. This data is then exported into a program where the results are visualized and processed for the creation of time-stepped inundation maps. Two processing methods are presented, and the steps for producing maps from the generated inundation are detailed.

1.2.3 Task 3: Data Analysis

Data analysis is performed on the generated output from each processing method based on criteria relevant to floodplain management applications. One criterion is the accuracy of the inundation boundary in depicting flooded areas due to existing topography. Other criteria relate to the use of the inundation boundary to determine the effects on critical infrastructure sectors, such as transportation systems, emergency services, and public health and healthcare. This analysis forms the basis for the conclusions of this research.

1.2.4 Task 4: Summary of Results

A concluding summary of the results is presented to review the key findings of this research. The benefits and potential drawbacks of each processing method are discussed. The comparison of these advantages and disadvantages results in the determination of the most appropriate processing method for inundation mapping.
2.0 Literature Review

Floodplain management involves corrective measures taken to reduce flood damage (FEMA, 2010). These measures also ensure the protection of life and health, the monitoring of flood control structures, the preservation of riparian areas and water quality, and the establishment of emergency management practices (Bond, 2009). In order to standardize floodplain management procedures, FEMA manages the National Flood Insurance Program (NFIP), which provides flood insurance, floodplain management, and flood hazard mapping (FEMA, 2010). Thus, inundation mapping is an important component of flood mitigation, allowing for emergency preparedness in the event of catastrophes, such as dam failures.

Dam failure inundation maps are crucial in the determination of the risk that dams pose to areas downstream. By providing a visual representation of the flood extents, inundation maps allow for the potential impacts to critical infrastructure to be examined. Critical infrastructure is classified by FEMA into the sectors shown in Table 1 (DHS, 2008).

<table>
<thead>
<tr>
<th>Sector-Specific Agency</th>
<th>CIKR Sector</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department of Agriculture&lt;sup&gt;1&lt;/sup&gt;</td>
<td>Agriculture and Food</td>
</tr>
<tr>
<td>Department of Health and Human Services&lt;sup&gt;4&lt;/sup&gt;</td>
<td></td>
</tr>
<tr>
<td>Department of Defense</td>
<td>Defense Industrial Base</td>
</tr>
<tr>
<td>Department of Energy&lt;sup&gt;6&lt;/sup&gt;</td>
<td>Energy</td>
</tr>
<tr>
<td>Department of Health and Human Services</td>
<td>Public Health and Health Care</td>
</tr>
<tr>
<td>Department of the Interior</td>
<td>National Monuments and Icons</td>
</tr>
<tr>
<td>Department of the Treasury</td>
<td>Banking and Finance</td>
</tr>
<tr>
<td>Environmental Protection Agency</td>
<td>Drinking Water and Water Treatment Systems</td>
</tr>
<tr>
<td>Department of Homeland Security</td>
<td></td>
</tr>
<tr>
<td>Office of Infrastructure Protection</td>
<td></td>
</tr>
<tr>
<td>Office of Cyber Security and Telecommunications</td>
<td>Chemical</td>
</tr>
<tr>
<td>Transportation Security Administration</td>
<td>Commercial Facilities</td>
</tr>
<tr>
<td>Transportation Security Administration/U.S. Coast Guard&lt;sup&gt;2&lt;/sup&gt;</td>
<td>Dams</td>
</tr>
<tr>
<td>Immigration and Customs Enforcement/Federal Protective Service</td>
<td>Emergency Services</td>
</tr>
<tr>
<td></td>
<td>Nuclear Reactors, Materials, and Waste</td>
</tr>
<tr>
<td></td>
<td>Information Technology</td>
</tr>
<tr>
<td></td>
<td>Telecommunications</td>
</tr>
<tr>
<td></td>
<td>Postal and Shipping</td>
</tr>
<tr>
<td></td>
<td>Transportation Systems&lt;sup&gt;7&lt;/sup&gt;</td>
</tr>
<tr>
<td></td>
<td>Government Facilities</td>
</tr>
</tbody>
</table>

---

<sup>1</sup> The Department of Agriculture is responsible for agriculture and food (meat, poultry, and egg products).
<sup>4</sup> The Department of Health and Human Services is responsible for food other than meat, poultry, and egg products.
<sup>6</sup> The Energy Sector includes the production, refining, storage, and distribution of oil, gas, and electric power, except for commercial nuclear power facilities.
<sup>2</sup> The U.S. Coast Guard is the SSA for the maritime transportation mode.
<sup>7</sup> As stated in HSPTIS-7, the Department of Transportation and the Department of Homeland Security collaborate on all matters relating to transportation security and transportation infrastructure protection.

Table 1: FEMA Sectors
In addition to displaying impacts on critical infrastructure, inundation maps representing successive time periods after a dam failure provide insight into the arrival times of the flood to locations downstream, allowing for effective coordination of emergency response measures. As a result, inundation maps are a vital part of Emergency Action Plans (EAPs), providing key information about the flood that can be used by various agencies. Therefore, inundation maps have a direct application to floodplain management practices and should be developed for dams of all hazard classifications.

The creation of time-stepped inundation maps based on a dam failure involves several programs: the Hydraulic Engineering Centers River Analysis System (HEC-RAS), HEC-GeoRAS, and ArcGIS Desktop. HEC-RAS is used to model the dam failure and generate the flow data for the ensuing flood. HEC-GeoRAS is then used to visualize the HEC-RAS output data in ArcGIS Desktop for further processing. The components in ArcGIS Desktop allow for the creation of the inundation maps.

2.1 HEC-RAS

HEC-RAS is a computer program developed by the United States Army Corps of Engineers to assist hydraulic engineers. This program performs one-dimensional hydraulic calculations for a full network of natural and constructed channels. HEC-RAS includes four one-dimensional river analysis components: steady flow water surface profile computations, unsteady flow simulation, movable boundary sediment transport computations, and water quality analysis. These components allow the user to perform numerous hydraulic calculations on geometric data and are discussed in more detail in the following paragraphs (USACE, 2011B).

The steady flow water surface profile computations are intended for water surface profiles that have gradually varied flow and can be used at various scales, from a single river
reach to a full network of river channels. The steady flow component in HEC-RAS allows for the modeling of subcritical, supercritical, and mixed flow water surface profiles. Manning’s equation serves as the basis for these computational procedures, and the momentum equation is used in situations where there is a rapidly varied water surface profile, such as hydraulic jumps, bridges, and river confluences. Additionally, the effects of various obstructions such as bridges, culverts, and weirs that may be contained in a floodplain can be incorporated into the computational data. Thus, these features make the steady flow component an appropriate means to evaluate floodway encroachments (USACE, 2011B).

The unsteady flow simulation is intended for simulating one-dimensional unsteady flow through a full network of open channels. Although this module was developed for subcritical flow calculations, other mixed flow calculations such as supercritical flow, hydraulic jumps, and drawdowns can also be performed. Similar to steady flow, hydraulic calculations for bridges, culverts, and other structures can also be carried out in the unsteady flow module. The features that are unique to the unsteady flow component include dam break analysis, levee breaching and overtopping, pumping stations, navigation dam operations, and pressurized pipe systems (USACE, 2011B).

The movable boundary sediment transport computations are intended for the simulation of one-dimensional sediment transport calculations resulting from scour and deposition over moderate time periods. This module is designed to replicate the long-term effects of scour and deposition in a stream channel that would result from modifying the frequency and duration of the water discharge and stage, or from altering the geometry of the channel. This system can be used to evaluate deposition in reservoirs, predict the influence of dredging on the rate of
deposition, estimate maximum possible scour during large flood events, and evaluate sedimentation in fixed channels (USACE, 2011B).

The water quality analysis is intended simply to allow users to perform water quality analyses, including the following: dissolved nitrogen, dissolved phosphorus, dissolved oxygen, and carbonaceous biological oxygen demand. These features serve a great purpose in environmental studies of streams and rivers (USACE, 2011B).

In addition to the four river analysis components, HEC-RAS has the capability to produce graphics and reports. The graphics include plots of the river system schematic, cross-sections, profiles, rating curves, hydrographs, and other hydraulic variables data. Also, with the function of RAS Mapper, users can perform inundation mapping of water surface profile results directly from HEC-RAS data (USACE, 2011B).

Although these features are beneficial to a variety of projects, many are outside the scope of performing a dam break analysis. Simply, a dam break analysis is performed using the unsteady flow simulation in HEC-RAS. The unsteady flow simulation is the most appropriate to use for this scenario because the flow characteristics at any given point downstream of the dam are expected to change over time.

2.2 HEC-GeoRAS

HEC-GeoRAS is a software program extension for use with ArcGIS Desktop that provides the user with a set of procedures, tools, and utilities for the preparation of GIS data for import into HEC-RAS and the generation of GIS data from HEC-RAS output. These tools include the ability to assign river and reach names to stream networks, assign station values to stream endpoints, and assign line type values (left, channel, and right) to flow paths. In addition to these the tools, HEC-GeoRAS allows users to develop geometric data, generate cross-
sectional cut lines, interactively plot cross-sections, and assign elevation values to levee alignments for interpolation. Output data from HEC-RAS simulations may also be processed by HEC-GeoRAS for GIS analysis for floodplain mapping, flood damage computations, ecosystem restoration, and flood warning response and preparedness (USACE, 2011A).

Based on the tools provided by HEC-GeoRAS, this program plays a vital part in the development of inundation maps. First, HEC-GeoRAS is used to set up the geometry data in ArcGIS Desktop, including all the terrain data for the study area. Next, the geometry data set up in ArcGIS Desktop is exported into HEC-RAS. With this data, HEC-RAS is run to produce an output file of the inundation. The output file is then imported back into ArcGIS Desktop through the use of HEC-GeoRAS. Once the HEC-RAS output is visualized in ArcGIS Desktop, the functions contained within this software allow for the creation of the inundation maps.

2.3 ArcGIS

ArcGIS is a system developed by the Environmental Systems Research Institute, Inc. (ESRI) to process geographic information. ArcGIS is used for a variety of services, including creating and using maps, compiling geographic data, analyzing maps, and sharing geographic information. Maps developed using ArcGIS provide a deeper level of analysis than traditional paper maps due to the types of data that can be input as well as the tools available for processing the data. For example, ArcGIS maps can include feature, raster, and terrain data in the form of map layers, and these layers can then be edited and combined in a variety of ways. The ArcGIS system contains several key components, such as ArcGIS Desktop, Mobile GIS, ArcGIS Explorer, ArcGIS Server, ArcGIS online, and ArcGIS.com. Each of these components provides functionality for specific applications: ArcGIS Desktop is software for the creation of maps on Windows computers, Mobile GIS allows for clients to access this information in the field, and
ArcGIS Explorer, ArcGIS Server, ArcGIS online, and ArcGIS.com allow for the sharing of created maps and information online. Since the sharing of maps online is not feasible for this application, ArcGIS Desktop is the most useful component of the ArcGIS system (ESRI, 2011A).

ArcGIS Desktop is the primary software program used to perform GIS tasks, including mapping, geographic data compilation, analysis, and information sharing. In order to accomplish these tasks, ArcGIS Desktop contains a suite of applications: ArcCatalog, ArcMap, ArcToolbox, ModelBuilder, ArcGlobe, and ArcScene. These applications are fully compatible and are easily integrated for data processing. ArcCatalog serves the primary role of data and file management, allowing for the organizing and previewing of data. This data can be easily added into ArcMap as a map layer in order to be compiled and analyzed. ArcMap uses the overlay concept for displaying data layers, which allows point and feature GIS data to be viewed on a basemap, such as imagery or terrain. ArcMap stores the geographic information of all layers in the map, which allows for analysis using ArcToolbox and ModelBuilder. ArcToolbox is a collection of all the available data processing tools that ArcGIS Desktop can perform on geographic data. These tools can either be selected individually or combined in a set data analysis procedure using ModelBuilder. Furthermore, ArcGIS Desktop can also be customized through optional extensions that provide specialized analysis capabilities. For instance, the 3D Analyst and Spatial Analyst extensions are used to perform three-dimensional spatial analysis on terrain data. While ArcMap performs three-dimensional analysis, the overlay of map layers only allows for the two-dimensional display of information. However, this data can be input into ArcGlobe and ArcScene for three-dimensional viewing and further analysis. Thus, ArcGIS Desktop is an
effective program for the display and analysis of geographic data, with capabilities that are used for projects in a wide variety of industries (ESRI, 2011B).

Based on the features and capabilities of ArcGIS Desktop, this suite of applications is a useful tool for the development of inundation maps based on a dam failure. Once the hydraulic modeling of a dam failure is completed, this data is input into ArcMap for further analysis. The 3D Analyst and Spatial Analyst extensions are used to perform spatial analysis on the flood based on terrain in the form of Light Detection and Ranging (LiDAR) data. The flood is then overlain on topography and aerial photography, and map layers containing the locations of key structures and transportation routes are added to the map. Thus, ArcGIS Desktop is used to create inundation maps that display flooded areas over time and the effects on cities downstream. These maps provide a graphical representation of the flood to emergency agencies to allow for the planning of dam operations and evacuation routes. All in all, the capabilities of ArcGIS Desktop make this program a valuable tool for the creation of time-stepped inundation maps.
3.0 Modeling and Mapping Methods

Before developing the steps that need to be carried out to create the time-stepped inundation maps, the input data for the procedures are identified. Two processing methods are then presented, followed by the procedure for producing the maps.

3.1 Data Acquisition

The USACE has provided a HEC-RAS model of a dam containing data for the bank points of the rivers, storage areas such as lakes and other dams, the river centerlines, and cross-section cut lines with the elevations of the river channels. Figure 1 shows the input data for the HEC-RAS program. The red dots represent the bank points, the blue polygons are the storage areas, the river centerline is depicted as a blue line, and the cross-section cut lines are displayed in green.

Figure 1: HEC-RAS Input
Some of these inputs come from field measurements compiled by the USACE’s field technicians and are visualized once the model is imported into ArcMap. However, the inputs are labeled slightly differently once imported. Bank points and storage areas are labeled the same, but the river centerline is labeled as “River2D” and the river cross-sections are labeled as “XS Cut Lines”.

Before using this data, the model had to be reviewed for accuracy. The field measurements could not easily be verified because of the immense amount of data that would need to be checked. Therefore, a visual inspection of the model was conducted by reviewing all the cross-sections in HEC-RAS to assess the profiles for physical accuracy. This process involved looking at the geometry of the cross-sections to determine if the data points were entered correctly. Once the model was inspected and verified, the other input data for this process could be identified.

The USACE also provided Digital Elevation Models (DEMs) of the terrain in the study area derived from LiDAR data. These DEMs have 2-meter, 10-meter, and 30-meter spatial resolutions. Spatial resolution is the dimension of the cells that compose the grid in a DEM; thus, 2-meter DEMs contain terrain data for 2-meter by 2-meter grid cells in the study area, yielding higher accuracy for the terrain than the 10-meter and 30-meter DEMs. As a result, the 2-meter DEMs are used in this research to produce an inundation accurate to within two meters. The coordinate system for the DEMs is the North American Datum of 1983 (NAD83) with the Albers equal-area conic projection. This projection is used to minimize distortion between the standard parallels when modeling the Earth on a two-dimensional plane.

Furthermore, the USACE provided a geodatabase containing the locations of critical infrastructure along the river. In order to provide a background for the maps, aerial photographs
of the rivers, transportation routes, and shapefiles containing the cities and counties in the United States were obtained from the West Virginia GIS Technical Center (WVGISTC, 2011). Thus, the database design is composed of points, lines, polygons, and fields. The data represented as points are bank points, cities, and critical infrastructure; the river centerlines, cross-section cut lines, and transportation routes are represented as lines; the polygons are the bounding polygon, the storage areas, and the flood; and the aerial photographs and DEMs are fields. Once the input data has been identified, the procedure for creating inundation maps is developed.

3.2 ArcToolbox Procedure

The creation of the inundation maps contains many steps and involves several programs: HEC-RAS, HEC-GeoRAS, and ArcGIS Desktop. In this procedure, the built-in functions found in ArcGIS Desktop are used to create the inundation resulting from a dam failure. The steps for this procedure are discussed in the following sections.

3.2.1 Create HEC-RAS Output Data

The first step in the process is to run the HEC-RAS failure model. There are many options to be specified, including the failure scenario and the time interval for the output data. For this simulation, hourly intervals are chosen for the output. The model is then run to produce output data for the inundation, such as the water levels and velocities at each time interval for each cross-section.

3.2.2 Export HEC-RAS Data

In order to visualize this data in ArcMap, the program must first export the data. After choosing Export GIS Data in HEC-RAS, a dialog box appears, as illustrated by Figure 2, and the
profiles, river reaches, and storage areas to be exported must be selected. In this procedure, the hourly profiles are exported for each river reach along with all storage areas.

![GIS Export](image)

**Figure 2: GIS Export**

### 3.2.3 Convert SDF File to XML File

The exported data are in the form of SDF files, which need to be converted in order to be used in HEC-GeoRAS. After opening ArcMap, the HEC-GeoRAS Toolbar is used to import the HEC-RAS data. First, the SDF file containing the exported HEC-RAS data is converted to an XML file, as shown in Figure 3.

![Convert RAS Export SDF to XML](image)

**Figure 3: Convert RAS Export**
3.2.4 Set Up Analysis Layer

Under RAS Mapping on the HEC-GeoRAS Toolbar, Layer Setup is selected. In the Layer Setup dialog box, shown in Figure 4, an analysis name is given, and the XML file is chosen as the basis for the river analysis. Also, the GRID option is used for the terrain to select the DEMs, which provide the topographic data for the analysis. Next, the output directory is specified to determine where the file will be saved.

![Layer Setup](image)

Figure 4: Layer Setup

3.2.5 Import HEC-RAS Output Data

After the Layer Setup is complete, the HEC-RAS data is imported into ArcMap. Under RAS Mapping in the HEC-GeoRAS Toolbar, Import RAS Data is chosen, and the Classic (Personal Geodatabase) option is selected, as illustrated by Figure 5, to import the data.
Once this step is completed, the bank points of the river, storage areas, river centerline, cross-section cut lines, and bounding polygon appear in ArcMap, as shown in Figure 6. The cross-section cut lines are represented by the green lines, the river centerline is the dark blue line that passes through the cross-sections, the storage areas are the light blue polygons, and the bounding polygon is outlined in pink.
3.2.6 Generate Water Surface TIN

The last HEC-GeoRAS tool used in the process is called Water Surface Generation, found in Inundation Mapping in the RAS Mapping dropdown menu. This tool creates a Triangulated Irregular Network (TIN) of the water surface for the river. The water surface profile is selected, as shown in Figure 7, and there are four options that can be chosen: Add Output Layers, Draw Output Layers, Smooth Floodplain Delineation, and Merge Floodplain Features. Of these options, only Merge Floodplain Features is left unchecked. Once the TIN is created, ArcToolbox is used to continue the analysis.

![Figure 7: Select Water Surface Profile](image)

3.2.7 Convert TIN to Raster

After the HEC-RAS data has been imported into ArcMap and manipulated into a form that can be processed by ArcMap, the tools in ArcToolbox are used to complete the inundation mapping. Under 3D Analyst Tools, the Conversion category is expanded, followed by the From TIN category, and the tool TIN to Raster is selected. For this step, the Water Surface TIN created with HEC-GeoRAS is chosen, and the TIN is converted into a raster file, as shown in Figure 8, and added into ArcMap.
3.2.8 Delete DEM from Raster

The next tool is also found under the Conversion category, but the Raster Math category is expanded to reveal the Minus Tool, shown in Figure 9. Using this tool, the DEM of the river is deleted from the raster of the water surface, and this file is also added to ArcMap.

3.2.9 Reclassify Raster

Under the Conversion category, the Raster Reclass category is expanded, and the Reclassify Tool is selected, as illustrated by Figure 10.
In the dialog box, the file created by the Minus Tool is chosen, and under Classify, shown in Figure 11, the Equal Interval Method is used to create two classes, one containing the negative values (classified as a one) and one containing the positive values (classified as a two). The reclassified file is then added to ArcMap.

3.2.10 Convert Raster to Polygon

The last tool used in the analysis is under the Conversion Tools category. In this category, the From Raster category is expanded, and the Raster to Polygon Tool, shown in
Figure 12, is selected. This tool converts the reclassified raster file into a polygon that represents the flood.

![Raster to Polygon](image)

Figure 12: Raster to Polygon

3.2.11 Delete Negative Values

After the polygon is added to ArcMap, the polygon layer is right-clicked in the Table of Contents, and the Attribute Table for the polygon is opened, as shown in Figure 13. The GRIDCODE attribute is then sorted by ascending values in order to group the negative values (signified by the number one). Using the Editor Toolbar, Start Editing is chosen with the flood polygon as the Target, and the negative values are deleted from the Attribute Table. The resulting polygon, shown in Figure 14, contains only positive values and represents the extents of the flood that results from the dam failure.

![Attribute Table](image)

Figure 13: Attribute Table
Once the flood has been modeled, the next step is to produce the inundation maps. To fully understand the flood extents, background imagery is used to provide context to the maps. The counties and cities in West Virginia are useful in displaying the location of the flood, so first the United States shapefile is added with the Add Data function. Under the Selection dropdown menu, Select by Attribute is chosen, and a query is used to select the state of West Virginia, as illustrated in Figure 15. The selection is added to ArcMap, and the layer is saved by right-clicking on the layer in the Table of Contents and choosing Export Data from the Data menu.
Next, the United States Counties and United States Cities shapefiles are added with the Add Data function. The Selection dropdown is expanded to reveal Select by Location, shown in Figure 16, where queries are used to select the counties and cities that are completely within West Virginia. Once again, the selections are saved using Export Data from the Data menu.
3.2.13 Add Background Imagery

Depending on the application, aerial photography or topographic data for the area may be useful, and both can be added relatively easily. TIFF files of aerial photography are added directly to ArcMap using the Add Data function, and the flood is overlain on the images, as shown in Figure 17.

![Figure 17: Flood Overlain on Aerial Photography](image)

In order to produce a topographic map, contours must be created based on the DEMs. Under the Spatial Analyst Toolbar drop-down menu, the Surface Analysis category is used to select Contour. In the Contour dialog box, shown in Figure 18, the desired DEM is chosen as the input surface, and the contour interval is specified. After choosing the output directory, the contours are created and added into ArcMap, and the flood polygon is overlain on the contours, as illustrated in Figure 19.
Figure 18: Create Contours

Figure 19: Flood Overlain on Contours
3.3 Terrain Tiles Procedure

The ArcToolbox procedure generates the flood based on terrain data for an entire river reach, which requires ArcGIS Desktop to process a large amount of data at one time. Thus, in order to reduce the amount of data processed at once, the DEMs are clipped into smaller sections called Digital Terrain Models (DTMs) and processed using the multiple terrain model function in HEC-GeoRAS.

3.3.1 Create New Polygon Shapefile

In order to create the DTMs, the first step is to create a new shapefile for the polygons used to clip the DEMs. After opening ArcCatalog, the Catalog Tree is used to locate where the new shapefile is created. Once the folder is selected, the shapefile is created by choosing File and then New Shapefile. In the dialog box that appears, a name for the shapefile is specified, and the feature type is chosen as polygon, as shown in Figure 20. A coordinate system can also be specified, but for this application, a spatial reference is not needed. Selecting OK closes the dialog box and creates the shapefile in the selected folder. After the shapefile is created, the process is continued in ArcMap.

![Create New Shapefile](image.png)

Figure 20: Create New Shapefile
3.3.2 Sketch First Polygon

After opening ArcMap, the new shapefile and DEMs are added using the Add Data function. In order to generate a continuous flood boundary, HEC-GeoRAS requires that every cross-section along the river is completely contained within one DTM. Thus, the cross-section cut lines and river centerline used in the HEC-RAS modeling are also added into ArcMap. Once this data has been added, the next step is to create the polygons that set the extents of each DTM. Using the Editor Toolbar, the Start Editing option is chosen. The shapefile layer is selected as the Target, and the task is Create New Feature. The Sketch Tool is used to draw a polygon around the first desired section of the DEM, ensuring that the boundary of the polygon does not intersect any of the cross-section cut lines. Figure 21 illustrates this concept by showing the polygon drawn around the desired section of the DEM, intersecting the river centerline between two cross-section cut lines.

![Sketch Polygon](image)

Figure 21: Sketch Polygon
3.3.3 Set Spatial Analyst Options

After the polygon is created, the polygon is saved by choosing Save Edits from the Editor dropdown menu. Next, Options under the Spatial Analyst dropdown menu is chosen, opening the Options dialog box, as shown in Figure 22. Figure 22a shows the General tab, where the analysis mask is set to the shapefile layer. Figure 22b illustrates the Extent tab, where the analysis extent is specified as the same as the shapefile layer, and the snap extent is specified as the DEM. Finally, Figure 22c shows the Cell Size tab, where the analysis cell size is chosen to be the same as the DEM.

![Figure 22: Specify Options](image)

3.3.4 Create DTM

After selecting OK, the Spatial Analyst dropdown menu is used to select the Raster Calculator Tool. In Raster Calculator, the DEM layer is chosen, and Evaluate is selected to create the clipped DTM, as shown in Figure 23.
The DTM is added into ArcMap as a layer named Calculation. This layer must be saved in order to be used in the HEC-GeoRAS processing. In order to do this step, Calculation is right-clicked upon, and in the resulting menu, the Data category is selected to reveal the Make Permanent Tool. In the Make Permanent dialog box, the destination folder where the file will be saved is specified, and a name is given to the file, as shown in Figure 24.

### Figure 24: Make Permanent

3.3.5 Create Remaining DTMs

After clicking Save, the polygon used for this DTM is deleted, and the Sketch Tool on the Editor Toolbar is used to create the next polygon, ensuring that this polygon overlaps part of the created DTM and that the boundary does not intersect any cross-section cut lines. Figure 25
illustrates this concept by showing the polygon overlapping part of the clipped DTM with the DEM layer turned off.

This process is continued until the entire DEM has been clipped into smaller, more manageable DTMs. In order for the DTMs to be processed by HEC-GeoRAS, Triangulated Irregular Networks (TINs) must be created. However, before TINs can be created, contours must first be generated following the same procedure discussed previously. Thus, one of the DTMs is added into ArcMap using the Add Data function. In the Spatial Analyst dropdown menu, the Surface Analysis category is selected to reveal the Contour Tool. In the Contour dialog box, the input surface is specified as the DTM, the contour interval is set, and the file destination is chosen. Selecting OK closes the dialog box and generates the contours based on the terrain data contained in the DTM. The contours are added into ArcMap as a layer, overlain on the DTM. To create the TIN, the 3D Analyst Toolbar is used. In the 3D Analyst dropdown menu, the Create/Modify TIN category is used to select the Create TIN From Features Tool. In
the dialog box, shown in Figure 26, the contours layer is checked to designate this layer as the basis for the TIN, and the destination for the output TIN is specified.

![Create TIN From Features](image)

**Figure 26: Create TIN**

Clicking OK generates the TIN in ArcMap, overlain on the contours and DTM. This process is continued for the other DTMs until each DTM has a TIN. The created TINs should all be saved in the same folder to facilitate processing in HEC-GeoRAS.

### 3.3.6 Add New Map

Once the DTMs and TINs have been created, HEC-GeoRAS is used to generate the inundation based on the multiple terrain models. To begin this process, a new ArcMap document is opened, and the document is saved. In the HEC-GeoRAS Toolbar, the ApUtilities dropdown menu is used to select Add New Map. In the ApUtilities dialog box, shown in Figure 27, the name Geometry is given to the new map, and selecting OK adds the map to ArcMap.
3.3.7 Add Geometry Data

After the new map is added, the TINs can be loaded. While HEC-GeoRAS does not require that the TINs be loaded into the Geometry map, this step can be used to ensure that the TINs overlap each other so that triangulation in the transition from one TIN to the next is performed correctly. Additionally, the river centerline and cross-section cut lines in the HEC-RAS geodatabase must be added to the Geometry map. Before continuing with the process, another check can be made to verify that each cross-section cut line lies completely within one TIN.

3.3.8 Create Terrain Tiles Layer

After adding this data into ArcMap, the next step is to create terrain tiles that set the analysis boundaries for HEC-GeoRAS. Under the RAS Geometry dropdown menu, Create RAS Layers is used to select the Terrain Tiles Tool, and the default name TerrainTiles is accepted by clicking OK in the Create Terrain Tile dialog box, as shown in Figure 28.
3.3.9 Create First Terrain Tile

Once the TerrainTiles layer is created in the Geometry map, the Editor Toolbar is used to set up the tiles for processing. In the Editor dropdown menu, Start Editing is chosen. The task is Create New Feature, and the Target is the TerrainTiles layer. Using the Sketch Tool, polygons are drawn along the river, and HEC-GeoRAS processes the data in each polygon individually. Since each polygon corresponds to one TIN, the Terrain Tiles procedure is facilitated by turning off the display of all TINs except for the one currently in use by unchecking the TINs in the Table of Contents. With only one TIN displayed, the polygon is drawn to incorporate as much of the TIN as possible, ensuring that each cross-section cut line within the polygon is completely within the bounds of the TIN, as shown in Figure 29.

![Figure 29: Sketch First Terrain Tile](image)

3.3.10 Edit Attribute Table

After the terrain tile is drawn, the Attribute Table of the TerrainTiles layer is viewed by right-clicking on the layer in the Table of Contents and selecting Open Attribute Table from the menu. In the Attribute Table, several columns need to be completed. In the TerrainType
Column, the number one is inserted to signify that the terrain is in the form of a TIN. The TileName is the name of the TIN that serves as the basis of analysis for the polygon. Finally, the TileDirectory is the full path to the folder where the TIN is saved. This process is demonstrated in Figure 30.

![TerrainTiles Attribute Table](image)

**Figure 30: TerrainTiles Attribute Table**

### 3.3.11 Create Second Terrain Tile

Once these columns have been filled in, the Attribute Table is closed. Next, the second TIN is displayed, and the first TIN is turned off. Before continuing with the next polygon, a check is performed to verify that the end of the first polygon overlaps the start of the second TIN for a continuous analysis. Using the Sketch Tool, the second polygon is drawn such that the two polygons are edge-matched, meaning that the start of the second polygon overlaps the end of the first polygon. Again, each cross-section cut line within the second polygon must be completely within the bounds of the second TIN, as shown in Figure 31.
In order to eliminate the overlap distance between the two polygons, the Edit Tool on the Editor Toolbar is selected. After selecting the first polygon with the Edit Tool, the Clip Tool in the Editor dropdown menu is chosen. In the Clip dialog box, the buffer distance is set to zero, and the option to discard the area that intersects is chosen, as illustrated in Figure 32.

Clicking OK closes the dialog box, and the second polygon is clipped to match the boundary of the first polygon.

Figure 31: Sketch Second Terrain Tile

3.3.12 Eliminate Overlap Distance

Figure 32: Clip Polygon
3.3.13 Populate Attribute Table

The TerrainTiles Attribute Table is opened once again, and the TerrainType, TileName, and TileDirectory columns are completed. The TerrainType is still the number one; however, the TileName is the name of the second TIN, and the TileDirectory is the path to the folder where the second TIN is located. This process is shown in Figure 33.

![Attributes of TerrainTiles](image)

Figure 33: Populated TerrainTiles Attribute Table

3.3.14 Create Remaining Terrain Tiles

Once this data has been filled in, the third polygon is drawn following the same procedure, and the process continues until all of the TINs have polygons. A last check is to verify that each cross-section cut line along the river is completely within a polygon and the TIN associated with that polygon. Once the TerrainTiles layer has been digitized, Stop Editing is selected from the Editor dropdown menu, and Yes is chosen in the dialog box to save the edits.

3.3.15 Export HEC-RAS Data

After the terrain tiles are set up for analysis, the HEC-RAS data is imported. HEC-RAS is opened, and the dam failure model is run, specifying the failure scenario and the time interval for the output data. Again, hourly intervals are chosen for the output data. Once HEC-RAS has run the model, the data is exported to be used in ArcMap. In HEC-RAS, the Export GIS Data function is selected from the File menu, which opens the GIS Export dialog box. The destination
for the export file is specified, and the river reaches, storage areas, and profiles to be exported are chosen. Since the terrain tiles limit the amount of data processed by ArcMap at one time, multiple river reaches can be exported together, rather than individually. For this simulation, all of the river reaches, along with all storage areas, are exported for the profile corresponding to the hour in which the dam fails. After choosing Export Data, the export files are created, and the analysis process is continued in ArcMap.

3.3.16 Set Up Analysis Layer

Returning to the ArcMap document containing the terrain tiles, the Import RAS SDF File Tool is selected from the HEC-GeoRAS Toolbar. The SDF file containing the exported HEC-RAS data is chosen, and clicking OK converts that file to an XML file. Next, in the RAS Mapping dropdown menu, Layer Setup is selected, which opens the dialog box displayed in Figure 34.

![Layer Setup dialog box](image)

**Figure 34: Analysis Layer Setup**

A name is given for the analysis, and the XML file containing the HEC-RAS output is chosen for the basis of the analysis. For the terrain data, the Multiple option is selected. For the
DTM Tiles Layer, the location of the terrain tiles dataset must be specified. By navigating to the folder where the processing data is being saved, the geodatabase for the analysis is found. Double-clicking on this geodatabase reveals the Geometry dataset created previously, and double-clicking on this dataset shows the TerrainTiles layer, which is chosen as the file that serves as the basis for the DTM analysis. Finally, the Output Directory for the save file is specified, and clicking OK finishes the Layer Setup.

3.3.17 Compute Inundation

The created layer appears as the active data frame in the Table of Contents. Next, Import RAS Data is selected from the RAS Mapping dropdown menu, and the Classic (Personal Geodatabase) option is selected to import the data in the HEC-RAS export file. After clicking OK, the bank points, storage areas, river centerlines, cross-section cut lines, and bounding polygon are displayed in ArcMap. Under RAS Mapping, Inundation Mapping is chosen to reveal the Water Surface Generation Tool. In the dialog box, the water surface profile is selected, and all the options are checked except for Merge Floodplain Features. Clicking OK generates a TIN of the water surface for the selected profile. Once the TIN has been created, the last step is to use the Floodplain Delineation Using Rasters Tool, found under Inundation Mapping in the RAS Mapping dropdown menu. In the Floodplain Delineation dialog box, shown in Figure 35, the water surface profile is selected, and all the options are checked except for Merge Floodplain Features; clicking OK starts the inundation analysis.
3.3.18 Post-Processing

When HEC-GeoRAS has finished computing the inundation, two separate layers are added into ArcMap depicting the inundated area. The first layer is labeled with a letter “b” followed by the name of the HEC-RAS export file, and this layer is a polygon showing the extents of the flood, displayed in Figure 36. The second layer is labeled as “dP001”, and this layer shows the water depths of the inundated areas, as illustrated in Figure 37.
Depending on the amount of data and the computer specifications, the processing time for the inundation can vary. For this procedure, the process took between 18 and 48 hours to compute the inundation over the entire study area for a specified hour after the dam failure. Also, the output file size can be very large; for example, the average file size of the inundation was 190 gigabytes for this simulation. This procedure was then used to produce the inundation for the other time periods after the dam failure.

3.4 Mapping Procedure

After the inundated areas are produced, the process of making the inundation maps begins. This process involves the use of many functions in ArcMap and several types of data. The following sections detail the individual steps in this procedure.

3.4.1 Mosaic DEMs

The Add Data function is used to add the DEMs of each river reach to the ArcMap document. The function Mosaic to New Raster, from the Data Management Tools in ArcToolbox, is used to merge all the DEMs together. In the Mosaic to New Raster dialog box, the DEMs from each river reach are chosen and given the name of Entire Study Area to denote the file as the combination of all the river reaches. After naming the file, an output file location is chosen to complete the process. With the DEMs combined, the Add Data function is used to add the combined file into the document, and the individual files are removed. Next, the contours are created from the Entire Study Area DEM.

3.4.2 Create Contours

To begin the process of creating the contours, the environment needs to be set in ArcMap. The Tools dropdown menu is selected, and Options is chosen from the menu. In the
Options dialog box, the Geoprocessing tab is selected, as illustrated by Figure 38, and under Environment Settings, Environments is chosen.

![Options dialog box](image)

**Figure 38: Options**

Inside the Environment Settings dialog box, the General Settings category is expanded, and the current and scratch workspaces are changed to the file folder that contains the DEM files, as shown in Figure 39.

![Environment Settings](image)

**Figure 39: Environment Settings**
This step allows for a faster processing time in creating the contours by limiting the area in which ArcMap has to work. After setting up the environment, Surface Analysis is chosen from the Spatial Analyst dropdown, and Contour is selected. In the Contour dialog box, shown in Figure 40, the Entire Study Area DEM is selected as the Input surface, and the Contour interval is changed from 100 feet to 50 feet. This interval allows for the most detail to be shown for the scale at which the inundation maps are produced for this application, but a smaller interval could have been selected. Also, in this dialog box, the Output features are changed to be saved in the folder that contains the DEMs.

![Contour Dialog Box](image)

**Figure 40: Create Contours**

### 3.4.3 Add Road Layers

After this process is complete, the contours are added to the Table of Contents and are drawn overtop the DEM. With the contours drawn, the DEM is removed, and the major and minor road layers are added. The road layers were downloaded from the West Virginia GIS Technical Center in the form of shapefiles. The major roads include state routes, US routes, and interstates, while the minor roads include county routes. The Add Data function is used to add
each of the road shapefiles as a layer to the ArcMap document. Since the roads span the entire state and the study area covers only a small portion of the state, the Clip function in ArcToolbox, found in the Analysis Tools category under Extract, is used to limit the roads to only the areas covered by the contours.

3.4.4 Create New Polygon Shapefile

To begin the process of clipping the roads, ArcCatalog is launched to create a new shapefile. To create a new shapefile, the folder that contains the road shapefiles is highlighted so that the new shapefile is saved within the same folder for easy access. The File dropdown menu is chosen, and the New menu is selected. Under the New menu, Shapefile is selected, opening the Create New Shapefile dialog box. The Name field is changed to Boundary to denote that the shapefile will be the boundary in which the roads are contained. After this step, the Feature Type is changed to a polygon so that the boundary that will be created is represented by an area. Also, the Spatial Reference is set by selecting Edit, which brings up the Spatial Reference Properties dialog box. Import is selected in the dialog box, and the Entire Study Area DEM file is navigated to and selected. This step gives the shapefile the same coordinate system and projection as the rest of the files that make up the inundation maps. Next, OK is pressed, and ArcCatalog is then closed.

3.4.5 Sketch Boundary Polygon

A new ArcMap document is opened, and the Add Data function is used to add in the Entire Study Area DEM, the new shapefile, and the road layers. With the layers added in, the Editor dropdown menu is chosen, and Start Editing is selected. The Start Editing dialog box opens, and Boundary is selected as the layer to edit. The Sketch Tool is then chosen to draw the boundary around the outside edge of the DEMs. The Zoom In and Pan Tools are used in
combination with the Sketch Tool to ensure that the boundary is aligned with the outside edge as closely as possible. In Figure 41, the road layers are displayed in the colors denoted in the Table of Contents, with the boundary polygon covering the Entire Study Area DEM.

![Figure 41: Boundary Polygon with Road Layers](image)

### 3.4.6 Clip Road Layers

Once the boundary polygon is created, the edits are saved by choosing Save Edits from the Editor dropdown menu. Next, ArcToolbox is opened, and the Analysis Tools tree is expanded. In Analysis Tools, the Extract tree is expanded, and Clip is chosen, opening the Clip dialog box, as illustrated in Figure 42.
In the Input Features box, one of the road layers is chosen, and in the Clip Features box, the Boundary shapefile is chosen. The Output Feature Class is set as the road folder, and the name is specified as Clip and the type of road. This process is followed for each type of road. After completion, the new ArcMap document is closed, and the clipped roads are added into the original ArcMap document with the use of the Add Data function. After the roads are added into ArcMap, the other critical infrastructure and cities are added in as well.

3.4.7 Add Critical Infrastructure and Cities

In addition to roads, critical infrastructure and cities are needed in the inundation maps to give an idea of the location and downstream impacts of the flood. To add in the critical infrastructure and the cities, the Add Data function is used once again. After the data is added into ArcMap, the symbols representing each category of infrastructure need to be changed in order to give a visualization of what types of infrastructure are impacted by the flood. Also, like the roads layer, there are cities and critical infrastructure that are outside of the study area that need to be clipped.

3.4.8 Clip Critical Infrastructure and Cities

The process of clipping is the same as the one used for the roads. First, the Boundary shapefile is added into ArcMap. Then Clip is opened from the Extract tree under Analysis Tools.
in ArcToolbox. In the Clip dialog box, the Input Features are changed to the Cities layer, and the Clip Feature is changed to Boundary. The Output Feature Class is the Cities folder, and the name of the file is changed to Cities_Clip. This step is then repeated for the critical infrastructure layers. Once the process of clipping the cities and critical infrastructure has been completed, the Add Data function is used to add in the clipped cities and critical infrastructure to ArcMap. Removing the original cities, critical infrastructure, and Boundary layers is the next step in the process, leaving only the clipped counterparts. After this step, the layers need to be labeled and assigned correct symbols.

3.4.9 Label Cities

To label and assign correct symbology to the Cities layer, the Label Features are turned on, and the symbol size is reduced to zero, leaving just a point. These steps are accomplished by double-clicking on the Cities_Clip layer, which opens the Layer Properties dialog box. Next, the Labels tab is selected, as shown in Figure 43, to change the label’s style and add a mask. Under Text Symbol, Times New Roman and a size of 20 is chosen for the font, as this font is the most appropriate for this application.

![Layer Properties](image)

Figure 43: Layer Properties
Next, the mask is added by selecting Symbol, then Properties, and finally the Mask tab. Under the Mask tab, a Halo with a size of 6 is selected under Style, as illustrated in Figure 44.

![Figure 44: Assign Halo](image)

By right-clicking on the Cities layer and selecting Label Features, the labels are activated and appear on the map. Next, the labels are converted to annotation by right-clicking the Cities_Clip layer and selecting Convert Labels to Annotation. This step opens up the Convert Labels to Annotation dialog box, shown in Figure 45.

![Figure 45: Convert to Annotation](image)
In this dialog box, **In the Map is selected under Store Annotation, and Convert is chosen.** By converting to annotation, the labels can be moved with the use of the Select Elements Tool.

### 3.4.10 Assign Symbology to Critical Infrastructure

To reduce the clutter of non-critical information in the inundation maps, the name labels are left off of the critical infrastructure layers. However, each critical infrastructure layer is assigned a symbol based on the type of infrastructure. This process involves identifying each type of infrastructure and double-clicking on the arbitrary symbol ArcMap provides when the data is first added in, which opens the Symbol Selector dialog box, shown in Figure 46.

![Symbol Selector dialog box](image.png)

**Figure 46: Select Symbols**

In the dialog box, the More Symbols menu is selected, and the different infrastructure categories are chosen from the list. Once the infrastructure categories are chosen, symbols are selected for each of the infrastructure layers based on the structure type. After the critical infrastructure layers have been assigned symbols, the major roads are then labeled.
3.4.11 Label Road Layers

The major roads of interstates, US routes, and state routes are the only types of roads labeled to minimize cluttering of the maps. The process for labeling the roads involves double-clicking on each of three types of roads and selecting the Labels tab from the Label Properties dialog box. Under Text Symbol, the font is changed to Times New Roman and size 8. Also, a Halo of size 2 is given to the label by selecting Symbol from the Layer Properties dialog box, then Properties, and finally the Mask tab. With all the features labeled and assigned appropriate symbols, the river is broken up into a selected size of 6-mile by 8-mile blocks to be mapped.

3.4.12 Create Blocks

To create 6-mile by 8-mile blocks, ArcCatalog is opened to create another new shapefile. This process is the same as creating the Boundary shapefile. Once the polygon shapefile is created and named MapAreas, ArcCatalog is closed. Back in ArcMap, the Add Data function is used to add in the newly created MapAreas shapefile. Next, the Editor dropdown menu is chosen, and Start Editing is selected. The Start Editing dialog box opens, and MapAreas is selected as the layer to edit. The Sketch Tool is then chosen to draw a 6-mile by 8-mile rectangle. The Measure Tool from the Tools Toolbar is then used to verify the rectangle’s dimensions. Once the MapAreas shapefile is created, as illustrated by Figure 47, the edits are saved by choosing Save Edits from the Editor dropdown menu.
Approximately 23 of these rectangles are needed to cover the entire study area, so Ctrl C is used to copy the rectangle and Ctrl V is used to paste 22 more copies while still in Editor. Once the 23 blocks are made, the Editor dropdown menu is used to save the edits and stop editing. The Select Elements Tool is then used to move the rectangles into position along the river. Once the river has been broken up into sections by the polygons, cross-sections that are representative of each area are labeled with the cross-section’s location and profile.

3.4.13 Select Cross-Sections

First, the cross-sections are added into ArcMap with the Add Data function. Next, the symbol size of the cross-sections is reduced to zero. This step allows for the cross-sections to appear to be nonexistent until the representative cross-section is chosen from the Attribute Table. The representative cross-section is chosen by selecting the cross-section as close to the middle of the 6-mile by 8-mile block as possible without overlapping any critical infrastructure symbols. To highlight the cross-section, the XS Cutlines Attribute Table is opened by right-clicking the
XS Cutlines layer and choosing Open Attribute Table. In the Attribute Table, shown in Figure 48, the cross-section is highlighted by selecting the gray box in front of the cross-section’s station number.

![Figure 48: Highlight Cross-Section](image)

After the Attribute Table is closed, the cross-section appears on the inundation map as a straight line across the river. In order to produce a profile with each cross-section, HEC-RAS is used.

### 3.4.14 Create Cross-Section Profile

In HEC-RAS, the View dropdown menu is chosen, and Cross-Sections is selected from the list. In the Cross-Sections dialog box, shown in Figure 49, the River, Reach, and River Station are chosen for the selected cross-section. After the cross-section is displayed, the Play function is used to animate the simulation results in order to select the water level at a specified hour after the dam failure.
Next, a screenshot is taken of the cross-section profile and is pasted into Paint where the profile can be cropped. In Paint, shown in Figure 50, the cross-section is cropped to show only the water level in the river channel, and the file is then saved to be inserted into ArcMap once the map template has been set up.
3.4.15 Choose Template

To switch from Data View to Layout View, the Layout View function is selected in the bottom left-hand corner of the screen. The next step is to create a map template for all the inundation maps. This step is accomplished by selecting the Change Layout function. The Select Template dialog box appears, as illustrated by Figure 51, and the LandscapeModernInset template is chosen from the list of templates. After the template is chosen, the page needs to be set up.

![Select Template Dialog Box](image)

**Figure 51: Select Template**

3.4.16 Set Up Page

From the File menu, Page and Print Setup is selected. The Page and Print Setup dialog box then appears, as shown in Figure 52, and the paper size and orientation are chosen. Also, the option to Scale Map Elements proportionally to changes in Page Size is chosen so that layers from the Data View do not become distorted.

52
3.4.17 Modify Template

After the Page and Print setup is complete, the template is then modified to the desired layout form with the use of guides. The guides are created by clicking on the page ruler at the desired locations, allowing features in the template to be snapped to the guides. Once the guides are set, the data frame and other areas are moved into place. Next, another data frame is inserted into the template as a spatial reference for the main data frame. To begin this process, the Data View function is chosen, followed by the Insert dropdown menu, and Data Frame is selected. A new data frame, with no layers inside, is added and named Entire by double-clicking New Data Frame in the Table of Contents and entering the new name. To act as a spatial reference for the main data frame, Entire is populated with the river, MapAreas, and WV Counties layers. This step is completed by using the Add Data function. Once the MapAreas are added into the data frame, a numeric system is assigned to denote the different areas. After this step is complete, the
Layout View function is selected, and the ArcMap template is saved. After saving, the inundation map is set up by manipulating the data frames and inserting additional information into appropriate sections.

3.4.18 Rotate Data Frame

The first step in setting up the inundation map is to rotate the data frame since the cardinal directions in Data View are oriented along the page rather than the coordinate system. This process is performed by selecting the main data frame in Layout View and right-clicking to bring up the Options dropdown menu. Once the dropdown menu appears, Properties is chosen, and the Data Frame Properties dialog box opens. In the dialog box, the General tab is selected, as illustrated by Figure 53, and Rotation is changed so that the lines on the MapAreas are straight. This step ensures that the rotation of the data frame is aligned with the boundaries of the MapAreas rectangles.

![Data Frame Properties](image)

Figure 53: Data Frame Properties

54
3.4.19 Assemble Data Frames

The first 6-mile by 8-mile block is centered in the main data frame. This step is aided by lining up the edges of the MapAreas rectangle with the edges of the data frame. Once completed, the scale is then changed to show a sufficient level of detail. Once the scale is set in the main data frame, the MapAreas layer is turned off in the Table of Contents to prevent the MapAreas rectangles from covering any critical information. Next, the minor data frame is activated in the Table of Contents by right-clicking on Entire and selecting Activate from the dropdown menu. This step allows for the manipulation of layers only inside the Entire data frame. Once activated, the MapAreas layer is chosen, and the Attribute Table is opened. In the Attribute Table dialog box, the first map area is selected by clicking the gray box in front of the map area. The map area is highlighted in the minor data frame, providing a spatial reference for the main data frame.

3.4.20 Insert Legends and Map Elements

Next, a critical infrastructure legend is inserted into the inundation map after deselecting from the minor data frame. To do this step, the Insert dropdown menu is selected, and Legend is chosen. Inside the Legend Wizard dialog box, shown in Figure 54, each critical infrastructure layer is added to the Legend Items box. After this step, a template for the legend is selected, and OK is clicked to insert the legend into the inundation map.
Once in the map, the legend is moved to a designated area. This process is repeated for inserting the flood extents legend. A north arrow and bar scale are added by selecting North Arrow and Scale Bar from the Insert dropdown menu. After setting up one inundation map with the two data frames, two legends, a north arrow, and a bar scale, a title is given to the map. The name “X Hours After Dam Failure” is given to the maps based on how many hours after the dam failure the inundation map is showing. Next, the representative cross-section profile for the map area is inserted into the map. This step is performed by selecting the Insert dropdown menu in ArcMap and choosing Picture. The image is then browsed to and selected. Once in ArcMap, the image is resized by double-clicking on the image and changing the width and height to appropriate sizes for the inundation map. Finally, the remaining 22 maps are produced for the set covering that hour, and this process is repeated for the other hours to be mapped.

### 3.5 Summary of Compiled Maps

The inundation was generated for the entire study area for the time period ranging from the hour of the dam failure to the hour of the maximum water elevation at the cross-section furthest downstream from the dam. Based on this time span, the inundation was produced at
three-hour intervals, except for the final interval, which was increased to four hours in order to capture the maximum water elevation at the last cross-section. These intervals provided an effective time-step, allowing the significant changes in the inundation of downstream areas to be shown over practical time periods. The maximum inundation for all downstream areas was also generated to show the extents of the entire flood event over the entire study area. In total, 23 inundation maps were produced for each of the 16 time periods in this research. In all, 368 maps were developed in this research.

Sample maps are contained in the following sections. Section 3.5.1 contains three inundation maps generated using the ArcToolbox procedure. The first map represents the river stage at the time of dam failure. The second map shows the river stage at the hour in which the water levels reach the maximum elevation. The third map illustrates the river stage at the last hour of the analysis, when the water levels are receding. Section 3.5.2 contains three inundation maps corresponding to the same time periods, but generated using the Terrain Tiles procedure. A comparison of these maps shows that the ArcToolbox procedure yields a good approximation of the inundation for a single river reach while requiring less processing time. However, a closer examination reveals certain flaws when computing the inundation for an entire network of rivers. An analysis of these flaws is discussed in Section 4.0.
Inundation Extents

0 Hours After Dam Failure

Figure 55: ArcToolbox Inundation (0 Hours)
Figure 56: ArcToolbox Inundation (21 Hours)

Inundation Extents

21 Hours After Dam Failure

Estimated Flood Extents
- Flood

- Police Stations
- County Courthouses
- Communication Towers
- Fire Departments
- EMS
- Hospitals
- Schools
- Water Treatment Plants
- Bridges
- Red Cross

Map No. 16
Figure 57: ArcToolbox Inundation (43 Hours)

Inundation Extents

43 Hours After Dam Failure

Estimated Flood Extents

- Flood

Legend:
- Police Stations
- County Courthouses
- Communication Towers
- Fire Departments
- EMS
- Hospitals
- Gasworks
- Water Treatment Plants
- Bridges
- Red Cross

Map No. 16

Projected Inundation Map
- Dam Failure
3.5.2 Terrain Tiles Maps

Figure 58: Terrain Tiles Inundation (0 Hours)
Inundation Extents

Figure 59: Terrain tiles inundation (21 Hours)
Figure 60: Terrain Tiles Inundation (43 Hours)
4.0 Processing Procedure Analysis

The analysis of the two processing procedures is performed through comparisons of the outputs and is based on the accuracy of the flood inundation. For the analysis, a candidate river reach is chosen, and the inundation is generated using both procedures. Figure 62 shows the inundation produced by the ArcToolbox procedure, and Figure 63 illustrates the inundation generated by the Terrain Tiles procedure. In order to focus the analysis, three separate zones along the river reach are examined: Zone A comprises a confluence of two rivers, Zone B contains a straight segment of the river, and Zone C encompasses a river bend.

For each zone, a set of criteria is used to compare the output from each procedure. The first criterion examines the water levels in relation to the topography and the propagation of the flood downstream. Other criteria involve the flood’s impact on critical infrastructure. Critical infrastructure is classified by FEMA into the sectors shown in Table 1 in Section 2.0; for this analysis, the following three sectors are examined: transportation systems, emergency services, and public health and healthcare. The legend containing the symbols for the critical infrastructure is shown in Figure 61. By following these criteria, the inundation produced by each procedure is assessed in regards to the overall effectiveness in emergency management and planning.

![Legend](image)

**Figure 61: Critical Infrastructure Legend**
Figure 62: ArcToolbox Full Reach
Figure 63: Terrain Tiles Full Reach
4.1 Zone A: Confluence

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Comparison</th>
</tr>
</thead>
</table>
| Hydrologic | - The ArcToolbox inundation (Figure 64) contains straight line segments between the model nodes where the river cross-section values of velocity, elevation, and flow rate are computed. The straight line segments do not conform to topography, causing inconsistent water levels and non-impacted flood areas to be displayed. The Terrain Tiles inundation (Figure 65) shows consistent water surface elevations throughout the floodplain for the same river segments. The water surface follows the contours, enhancing the visual interpretation of flooded areas for immediate decision-making by emergency responders. Based on the hydrologic comparison, the Terrain Tiles procedure is more accurate in determining flood boundaries and depicting the actual consequences of a flood resulting from a potential dam failure.  
- After the confluence, the ArcToolbox procedure overestimates the combined flow of the two rivers, as shown by the increase in water surface elevation around the bend of the river. The Terrain Tiles procedure computes the flow more precisely, and the resulting inundation levels follow the topography around the bend. Thus, the Terrain Tiles procedure renders increased precision in calculating the increased flow rates at river confluences. |
| Critical Infrastructure | - Both the ArcToolbox and Terrain Tiles procedures show that the bridges are impacted by the flood. However, the ArcToolbox procedure is inconsistent in depicting the transportation routes impacted by the flood, as the geometric shapes overlap in some areas while leaving other areas free from inundation. As a result, the ArcToolbox procedure leaves uncertainty as to which routes and structures are affected, making the Terrain Tiles procedure the more effective method for determining evacuation routes and potential safety zones.  
- Both procedures indicate that the emergency response facilities are impacted. Therefore, both methods satisfy this criterion.  
- The ArcToolbox inundation covers the school, hospital, and county courthouse. However, in each case this depiction is incorrect. The school is shown to be impacted as a result of the overestimation of flow from the confluence. The hospital and county courthouse are impacted due to the geometric representation of the inundated area. These inaccuracies may lead to a misuse of time and resources evacuating these areas when in reality there is no danger to these facilities. Thus, the Terrain Tiles inundation is the better tool for identifying viable evacuation centers. |
Figure 64: ArcToolbox Confluence

Figure 65: Terrain Tiles Confluence
4.2 Zone B: Straight Segment

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Comparison</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hydrologic</td>
<td>• The ArcToolbox inundation (Figure 66) is composed of unconnected and non-uniform geometric shapes that do not follow topographic control. This output renders visually confusing information indicating both flooded and non-flooded river reach segments. The water surface shows raised water elevations at steep ground slopes, while areas at lower elevations are not flooded. On the other hand, the Terrain Tiles procedure (Figure 67) shows a continuous inundation consistent with contours throughout the segment. Therefore, the Terrain Tiles procedure is more precise in computing and rendering a topographically correct inundation map for straight segments of river reaches.</td>
</tr>
<tr>
<td></td>
<td>• The ArcToolbox procedure does not show any flooding in the tributary stream, whereas the Terrain Tiles inundation includes flood water flow into the tributary stream. This flaw in the ArcToolbox output may lead to an underestimation of flood extents and damage. Hence, the Terrain Tiles procedure generates a better inundation when tributary flow needs to be taken into account.</td>
</tr>
<tr>
<td></td>
<td>• The ArcToolbox method underestimates the impact of flood debris production and accumulation during water recession. The exactness in water surface elevations may provide information for emergency transportation access as well as the identification of zones of heavy debris blockage.</td>
</tr>
<tr>
<td>Critical Infrastructure</td>
<td>• Due to the unconnected geometric inundation, the ArcToolbox output fails to provide a definite representation of bridges that are impacted by the flood. In Figure 66, the bridge is shown not to be impacted by the flood waters. Also, the geometric shapes leave uncertainty as to whether entire roads are obstructed or only certain parts of the roads. This uncertainty may hinder the planning of emergency response and evacuation routes as well as mislead responders into believing a major bridge is unaffected by the flood. In the case of the Terrain Tiles output, the inundation clearly shows a constant elevation, which allows for the impacts to transportation routes to be determined based on topography. Consequently, the Terrain Tiles inundation provides a definite depiction of the flood’s impact on evacuation routes.</td>
</tr>
<tr>
<td></td>
<td>• Since no other infrastructure is present in this segment, the comparison of the two procedures is limited to transportation routes.</td>
</tr>
</tbody>
</table>
Figure 66: ArcToolbox Straight Segment

Figure 67: Terrain Tiles Straight Segment
### 4.3 Zone C: River Bend

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Comparison</th>
</tr>
</thead>
</table>
| Hydrologic              | • The ArcToolbox inundation along a river bend (Figure 68) tends to be more unconnected with varying geometric shapes, resulting in inconsistent water levels. The Terrain Tiles inundation (Figure 69) holds to the topography around the bend and remains continuous. Therefore, the Terrain Tiles procedure is more accurate in determining flood boundaries in river bends.  
  
  • The ArcToolbox procedure is inconsistent in showing tributary flow, as one tributary shows no flooding while the other shows incomplete or partial flooding. As a result, the true impact of the flood in the tributaries remains unknown. However, the Terrain Tiles inundation includes flow into both tributaries, clearly depicting the extents of flooding in those areas. Thus, the Terrain Tiles inundation illustrates a more accurate representation of the flood’s propagation downstream.  
  
  • Around the bends in the river, the ArcToolbox procedure overestimates the flow of the river, as shown by the flow of water into higher elevations in the bends. This analysis shows land areas on ridge tops flooded, while valley bottoms remain unaffected. The Terrain Tiles procedure generates a topographically correct inundation that accurately represents the flow around the bends. Thus, the Terrain Tiles procedure is the most appropriate for computing flood extents at river bends. |
| Critical Infrastructure | • The inundations generated by the ArcToolbox and the Terrain Tiles procedures both show that the bridges are flooded. However, the ArcToolbox inundation is unreliable in depicting the transportation routes impacted by the flood due to the unconnected geometric shapes and the overestimation of the flood around the river bends. Therefore, the ArcToolbox procedure is inaccurate in showing the affected routes, inundated areas, and debris accumulation, making the Terrain Tiles procedure the preferred tool for planning evacuation routes.  
  
  • The ArcToolbox inundation indicates that the emergency response facilities are safe from the impacts of flooding. However, this representation is incorrect since the facilities are located in a tributary where ArcToolbox fails to show any flooding. This error may have serious consequences if these facilities are not evacuated based on this map. Thus, the Terrain Tiles map is more useful in determining emergency response and evacuation centers. |
Figure 68: ArcToolbox River Bend

Figure 69: Terrain Tiles River Bend
5.0 Conclusions

Inundation mapping is a vital component of floodplain management, providing engineers and emergency responders with the arrival times and impacts of the flood on critical infrastructure for the development and implementation of Emergency Action Plans. The creation of inundation maps requires the use of several programs, such as HEC-RAS, HEC-GeoRAS, and ArcGIS. However, there is no set procedure for producing the maps, and different processing methods yield widely varying results from the same input data. Therefore, an assessment of two processing methods was performed to determine the appropriate uses of the methods in floodplain management.

The inundation resulting from a dam failure for a candidate river system was generated using both the ArcToolbox and Terrain Tiles procedures, and time-stepped inundation maps were produced in accordance with floodplain management practices. A comparison of the two outputs revealed several key differences in the inundation based on criteria pertinent to emergency management. The ArcToolbox procedure proved to have a faster processing time than the Terrain Tiles procedure and yielded a comparable inundation for single river reaches. As a result, the ArcToolbox procedure is better suited for this application due to the processing time and storage requirements associated with the Terrain Tiles procedure. However, when computing inundation for large river networks, the Terrain Tiles inundation surpassed the ArcToolbox inundation in many areas. The ArcToolbox inundation was composed of unconnected geometric shapes depicting water levels that were inconsistent with the topography. Further inadequacies included the overestimation of flow rates at confluences and river bends as well as the inability to correctly depict tributary flow. In contrast, the Terrain Tiles procedure produced a continuous inundation that conformed to topographic controls and accurately
illustrated flood extents at confluences, river bends, and tributaries. The precision of the Terrain Tiles inundation outweighs the potential drawbacks of the procedure when a high level of detail is required, as is the case in floodplain management. Thus, the Terrain Tiles procedure is a more integrated, accurate, and precise graphical interface tool for the development and interpretation of flood extents by floodplain engineers and emergency responders.
6.0 References


